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Preface

This manual is truncated version of the complete 
PromoLog manual and attempts to provide a 
quick and easy guide to help users get started with 
PromoLog.

This manual may contain references to 
chapters that only exist in the complete 
version of PromoLog user manual. The 
complete version can be downloaded from 
www.nokeval.com/promolog.

Notation Conventions

The following notation conventions are used 
throughout this manual. 

Navigation

A menu selection and other types of selections will 
have greater than signs indicating how to navigate:  
Menu > Submenu > Selection

Fonts

This font indicates a parameter.
This font indicates a file name.

Symbols

 This symbol incicates a note or a tip.

 This symbol indicates something important.
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Interface  
for serial communications

Transmitters

USB/RS485
converter

Input Module

I/O device

RS485 Serial Bus

Several data recorders can 
be used for saving data 

Complex calculations can be made using  the Mathematic Functions 
module. The result is be displayed and can act as a source to other 
modules

Link Display 

Review 

Input Module  

Mathematic 
Module 

Link Display 
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Input Module
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Link Display 

1 2

Link Display 

Link Display Link Display 

Mathematic 
Module

Manual InputMathematic 
Module

Input channels

Reports

Output Module 

1 2 3 4

To Output Module

mA/V outputs

Data Recorders

TCP/IP connection for 
remote PromoLog  

RS232

PromoLog Software

RS232
  USB

Sheets 1 Sheets 2

The number of sheets is 
unlimited.

Link connection
to other sheets

Link connection
to other sheets

GSM modem
for alarms

Field instruments Wireless 
Receivers

Data ProcessingInput Visualization Recording Output

Link Display 

Introduction

PromoLog is a modular data acquisition software allowing you to design customized applications matching 
your needs.
 
Applications  are created by dragging suitable modules from library onto the screen. Both wireless and wired 
transmitters are supported without channel limits. You can also place photos or drawings on the background. 

The modules are divided into six different classes: Input, Data Processing, Visualization, Recording, Output 
and Network. The following block diagram shows some modules and how they can be linked.
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PromoLog

Reports

Alarms

GSM-alarms

Receiver
RTR970

Repeater
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Wired transmitters

Multip
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transmitte
rs

Repeaters can be placed near closed steel 
cabinets to extend the distances between 
transmitters and the receiver.

Typical Application for PromoLog Software

USB/
RS232

PromoLog supports devices that use either 
Nokeval SCL or Modbus RTU protocol.
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Installing

Installing PromoLog is easy. Start by locating the 
installation package setup.exe. This package can be 
obtained either from the Nokeval Software CD or 
from the Nokeval Web Server at address:
http://www.nokeval.com/promolog/setup.exe

Run the installation program setup.exe. A wel-
come screen is shown. Proceed by clicking Next.

A system information screen is shown next. This 
screen has information on the target computer sys-
tem. PromoLog has certain minimum computer and 
operating system requirements. This screen shows 
which of these requirements are met. The minimum 
system requirements are:

Operating System: Windows 2000 or Windows XP
RAM (Central memory): 128 MB minimum
Processor: 500 MHz minimum
USB ports or Serial COM ports required

 PromoLog will install and may work on  
 systems with inferior specifications, but 
this is not recommended nor supported by 
Nokeval.

If the minimum system requirements are met, pro-
ceed by clicking Next.
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Select the destination directory (folder) for 
PromoLog. The default installation folder is:
C:\Program Files\Nokeval\PromoLog

When ready, proceed by clicking Next>.

This screen provides an opportunity to select which 
optional components of PromoLog are to be in-
stalled. It is recommended to install all components.

When decided, finish the installation by clicking 
Install.
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Startup

Start PromoLog with the shortcut icon placed on 
the desktop by the installation program. This short-
cut is also added to the Windows Start Menu under 
the program group Nokeval > PromoLog.

During PromoLog startup a splash screen of the 
PromoLog Hardware Interface Layer (PHIL) is 
shortly displayed. This is perfectly normal.

PromoLog main window will appear on the screen 
in the welcome application state when the startup is 
complete. It should look similar to the example on 
the left-hand column.

Select New Application if you want to start build-
ing your own application or Open Application if you 
want to open an existing application.

You can also start example applications to get more 
familiar with PromoLog. 

You can disable the welcome screen from the Show 
Welcome Screen on Startup button. 

To enable the welcome screen select File > Prefereces  
and then set the Use Welcome Application param-
eter to Yes.

Welcome Screen
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User Interface

Toolbar

 Print active Sheet on the default Windows 
printer.
Shortcut: Ctrl-P

 Open Input Channel List window.

 Open Output Channel List window

 Open Alarm List window.
Shortcut: F8

 Open Module Library window.
Shortcut: F6

 Open Module List window.
Shortcut: F9

 Open Time Control Panel.
Shortcut: Ctrl+F5

 Start PromoLog Application
Shortcut: F5

 Stop PromoLog Application.
Shortcut: F5
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Sheets

Sheet tabs can be used to quickly select the active 
Sheet.

Status Bar

Status Bar displays useful tips and important status 
information.

 

Message Field
Displays status messages and usage tips depending 
on the situation and the position of mouse pointer. 

Application Mode
Displays ”Design”, ”Starting”, ”Simulating” or ”Real-
time” depending on the Application operating mode. 

Date and Time Field
• Design Mode: Displays the current date and time.
• Starting Mode: Displays progress percentage.
• Simulation Mode: Displays current simulated date 
and time.
• Realtime Mode: Displays current date and time.

Alarm Status Field
Displays the number of active alarms. Click to open 
Alarm list. 

Script Status Field
Displays the number of running scripts. Click to 
open Script Center. 

License Status Field
Displays PromoLog license status. If the license can-
not be validated, a red exclamation point is shown. 
Click to open License Management window. 

Processing Load Field
Displays approximate Application processing load 
percentage and a scrolling graphical representation 
of processing load during the past few seconds. Load 
percentage should normally stay well below 50% to 
ensure smooth operation. It is normal in multitask-
ing Windows environment for the load to momen-
tarily peak even at or above 100%.

A

B

C

D

E

F

G

E = Script Status Field
F = License Status Field
G = Processing Load Field

A = Message Field
B = Application Mode
C = Date and Time Field
D = Alarm Status Field
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The main and default language in PromoLog is 
English but some modules in PromoLog are multi-
lingual. 

To change the language used in these modules it is 
necessary to change the Language parameter of the 
application.

To do this, select Application Setup from the Design 
menu or press F2.

Select the Language parameter from the left-hand 
pane and then select the language you want.

Press the close button to exit the parameter editor
window.

Language
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Licensing

After the first startup, PromoLog is working in 
demo mode. PromoLog is fully functional in demo 
mode and all modules and features can be freely used 
and tested. The only limitation is that the application 
can be run in the active mode for only 5 minutes at a 
time.

If you have already purchased a license for 
PromoLog, then you can start licensing your copy of 
the software immediately. Licensing operations are 
done in the License Management window. To open 
this window, select menu Operate > License.

Another way to open the License Management win-
dow is to click the License panel in the status bar. 

Read on to learn more about PromoLog licensing.

Nokeval devices that can be used as dongles

• USB to RS485 Converter DCS770 (USB)
• USB to RS485 Converter DCS771 (USB)
• USB to POL Converter DCS772 (USB)
• RCS770 USB / RS485 / RS232 converter (USB)
• Radio Data Receiver MTR970 (SCL)
• Radio Data Receiver RTR970 (USB/SCL)
• Radio Receiver with Logger  

RTR970PRO (USB/SCL)
• 16 Channel Transmitter RMD680 (SCL)
• 2 Channel Transmitter 6821 (SCL)
• Strain Gauge Transmitter 6841 (SCL)
• Programmable Transmitter7100 (SCL)
• I/O Transmitter 7181 (SCL)

PromoLog licenses are based on license keys. Each 
key is bound to and authorized by a hardware 
dongle.

Various Nokeval serial transmitters and converters 
can also function as hardware dongles for PromoLog 
license keys. So, in most cases, a dedicated license 
key dongle is not needed. Instead, the license key can 
be bound to one of the serial transmitters or con-
verters that are connected to the computer running 
PromoLog.
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The License Management window is divided into 
two frames. The upper frame has a list that shows 
the entered license keys and two buttons for adding 
and removing them.

The lower frame shows the licensing status of the 
current application versus the available and autho-
rized licenses. This frame also provides contact infor-
mation for obtaining or upgrading a software license 
for PromoLog.

To use a USB device for license key authorization, it 
is enough to connect the device to the computer and 
install the USB drivers.

To use an SCL device, it is necessary to connect 
it to the computer and fully configure it for use in 
PromoLog. Read more about how to do this from 
the chapter discussing the device type in question. 
For example, if you are using Nokeval 7100  trans-
mitter see the chapter Nokeval Serial Transmitter.

To license your copy of PromoLog, check that you 
have the PromoLog Software License Agreement 
which bears the license key, and the associated li-
cense key dongle device at hand.

 To identify the correct license key dongle  
 device, you need to check the serial number 
of the device. The license key begins with the 
serial number of the associated dongle device.
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When a valid license key is entered, it is stored in 
the PromoLog license key file and it appears in the 
license key list.  The list shows the channel allow-
ance and licenses enabled by each key.

In this example, the license level check list in the 
lower frame shows that the Lite level license is now 
available but not yet authorized (the light beside the 
license level name is yellow). The license key dongle 
device needs to be connected and configured for 
authorization.

To enter the license key, click the Enter New Key... 
button on the License Management window. A 
small entry window appears, prompting to enter a 
license key. Type in the license key, exactly as print-
ed on the license agreement and press ENTER or 
click OK.

When the license key dongle device is connected 
to the computer and recognized by PromoLog, the 
license level is authorized and the light beside it 
turns green.

For information on how to connect and configure 
USB based dongle devices refer to the chapter In-
stalling USB drivers.

For information on how to connect and configure 
SCL based dongle devices refer to the chapter dis-
cussing the device type in question.

Click the List Connected License Authorization 
Capable Devices... button to see a list of recognized 
license key dongle devices that are currently proper-
ly configured and connected to the target computer.

The list shows the serial numbers and device types 
(USB or SCL) of the dongle devices.



17PromoLog User Manual

Application Time Control

Application Time Control window is mainly used 
to control the recovery of data from RTR970PRO 
receiver and binary channel data saved to hard disk 
by PromoLog. It can be also used to schedule the ap-
plication to run for a certain time period.

Open the Application Time Control window by 
clicking the  icon on the toolbar or by pressing 
Ctrl+F5.

Begin

Application Time Control window has three options 
for starting the application.

Now
No data is loaded from the flash memory of the 
RTR970PRO receiver nor from hard disk. 

Automatic
PromoLog detects the latest value that has not been 
loaded from the flash memory of the RTR970PRO 
receiver and runs time simulation from that moment.  
Also binary channel data from hard disk will be 
processed from that moment forward.

Time simulation in PromoLog means that data that 
was recovered from the RTR970PRO receiver or 
from binary channel data files is processed equally as 
data received when PromoLog is normally running. 

The amount of this data can be quite large and 
therefore the simulation can take quite a long time in 
some cases.

User defined
User can freely define the start time. PromoLog 
loads data from that moment forward from the flash 
memory of the RTR970PRO receiver and runs time 
simulation. Also binary channel data from hard disk 
will be processed from that moment forward.
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End

Application Time Control window has two options 
for stopping the application.

Manual
The application needs to be manually stopped by 
pressing the stop button.

User defined
User can freely define the stop time. Application is 
stopped when the time is reached.

When the application is running the Application 
Time Control window can be closed from the small 
cross button at the top right-hand corner.

The stop button is equal to the button on the 
toolbar.

History simulation example

If you want to examine a certain time period after-
wards, select the wanted start and stop times and 
start the simulation. 

In the example picture on the left-hand column a 
four hour period two days ago was chosen.

After the time simulation all channels PromoLog are  
in the same state as they were two days ago.
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Channel types

 Data Source

Modules that provide data themselves have Data 
Source channels. 

Most of the modules in the input category in 
PromoLog have Data Source channels but also Data 
Processing modules produce data and have Data 
Source output channels.

For example, the type of the input channel of the 
Nokeval Serial Transmitter module is Data Source. 

Data Source channels have a ring buffer that can be 
accessed by Data Link channels.

Channels

 Data Buffer

Data Buffer channels are channels that record the 
value of a selected parameter or channel with given 
interval. For example, Single Trend Plotter has a 
Data Buffer channel.

Data Buffer channels also have a ring buffer that can 
be accessed by Data Link channels.

PromoLog is a modular program and data between 
modules is mainly transferred through channels. 
Also parameter values can be used as data sources in 
some cases.

One module can have several channels and the type 
of the channels can vary. The pictures on the left-
hand column shows some examples how channels 
can be used.

Link Display Single Trend 
Plotter

Nokeval Wireless 
Transmitter

Data Source channel
Data Link channel

Data Buffer channel

Parameter value

Manual Input

Mathematic
Function

Link Display

USB/RS485
converter

Nokeval Serial  
Transmitter 

6821

Nokeval 6821
2 channel transmitter

Interface  
for serial communications

Nokeval Serial  
Transmitter 

6821

Single Trend 
Plotter

Single Trend 
Plotter

Manual Input

PromoLog Software

Field instruments
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 Data Link

Data Link channels do not have their own buffers. 
Data Links are pure links to Data Source channels,  
Data Buffer channels or to parameters. 

If the source of a Data Link channel is an unbuffered 
parameter value, only the latest value is available for 
the Data Link channel. Because of this, for example, 
a Link Display module cannot plot graphs for un-
buffered parameters but Single Trend Plotter can.

The advantage of using modules with Data Links 
instead of Data Buffers, is smaller memory con-
sumption. 

Link Display 

Single Trend 
Plotter

Nokeval Wireless 
Transmitter

Link Display 

Channel Settings

Configuring different channel types in PromoLog 
is quite similar. This example assumes that a Single 
Trend Plotter module is created as instructed on 
page 82. 

To view the channel’s settings double-click the 
module when the application is stopped and select 
the  parameter from the left-hand pane.

A source for Data Buffer and Data Link channels 
can be linked using the Y Source button. Linking the 
channels is explained next in this chapter.

The Value button opens the Channel Buffer Win-
dow that can be used to export and print channel 
values. The Channel Buffer Window is explained at 
the end of this Chapter.

Channel values can be logged to hard disk by select-
ing the Log to file check box. For more information, 
see page 120.

Channel type

Channel name
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Linking channels

There are two different ways to link channels. In 
other chapters of this manual only Resource Browser 
is used because it is capable of linking all possible 
sources. 

1. Drag&drop
Input channels are commonly used as sources to 
other modules. The fastest and easiest way to link 
these channels is by dragging the channels directly to 
the destination module’s  parameter page.

Open the Input Channels window by clicking the 
 button on the toolbar. Open also the destination 

module’s parameter editor and select the  para-
meter.

In the example pictures on the left-hand column, a 
input channel is added to a Data Recorder module 
and to a Multi Trend Plotter module.

Input Channels Output Channels

Modules where the number of channels is not fixed 
have an area where channels can be dropped to auto-
matically create new channel to the module.

Select the input channel you want to add from the 
Input Channels window. Then drag the selected 
channel over the “Drop object here to create a new 
Channel” text and drop the object.

In modules where the number of channels is fixed 
select the wanted   parameter and drop the object 
to the Y Source field.

Also Output channels can be equally linked. Note 
that only input and output channels can be linked 
using this method although other parameter values 
are also supported as inputs.



PromoLog User Manual22

2. Resource Browser

Click the Y Source Button to open the Resource 
Browser window. Resource Browser is a tool for link-
ing PromoLog’s resources to channels. All channels 
and parameters can be selected as a source using the 
Resource Browser.  Resource Browser cannot be used 
for editing parameter values. 

Toolbar

 Pick
Use the Pick button to set the selected resource as a 
source.

 Cancel
Use the Cancel button to close the Resource Browser 
without changing anything.

 Find
You can search all resources using a key word using 
the find button. Type in the search phrase to the Ref. 
text box and click the Find button. All matching 
resources are highlighted using red color.

 Find Ref
This option is for advanced users. You can find a 
resourcce from the parameter tree by typing the cor-
responding reference, for example  
CMTRTransmitter#104=Input, to the Ref. text box.

 Refresh
The refresh button rebuilds the whole resource tree 
of the selected source.

When using Remote Access Client you can choose 
remote PromoLog as a source from the Source drop-
down menu.
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To open the Resource Browser select the wanted   
parameter and press the Y Source button.

Resource tree

The resource tree is divided into two main branches. 
The PromoLog branch marked with  contains 
program wide parameters that are rarely used as  
inputs to other modules.

The Application branch marked with  contains 
application wide resources including all sheets and 
modules. The Modules subbranch marked with  
contains all modules in the application. 

If the selected resource is valid as a source the back-
ground color of the Ref. field is green.

Select the input source that you want from the re-
source tree and click the pick button. 

The green background color on the Ref. field in-
dicates that the source is valid and red respectively 
indicates an invalid source. The background is blue if  
the channel is linked to a parameter called Nothing.
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Channel Buffer Window

The Channel Buffer window can be opened by 
pressing the Value button. This window lists all val-
ues from the buffer with time stamp.

Toolbar

 Find
This button moves the time defined by date and time 
boxes to topmost in the view. 

 Export
Use this button to export channel values to a text file.    
Pressing this button opens a new window where 
more specific parameters are set.

 Print
Use this button to print channel values to default 
printer.

Export/Print Channel Data

Some parameters cannot be changed when printing 
channel values.

Begin and End fields are used to select the time 
period to export or print.

File Format
• ASCII Text: Data is saved in ASCII text format.
• Binary: Data is saved in binary format.  

Time Format
• General Date: dd.mm.yyyy hh:mm:ss
• Decimal: days from 30.12.1899, e.g. 38965.56

Number Format
This setting defines the number formatting.

Dec. separator
Pediod or comma can be selected as a decimal sepa-
rator.

Field separator
Tab, Semicolon, Colon or Backslash can be selected 
as a field separator.

Record separator
CRLF, CR, LF or Tab can be selected as a record 
separator.
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Sheets

To add or otherwise manipulate sheets, select menu 
Design > Sheets... or press F3.

Adding
Click the blue plus button to add a new sheet. The 
new sheet will appear at the end of the sheet list. 
A new sheet tab will also appear in the PromoLog 
main window’s sheet tab row.

Organizing
To change the order of the sheets, select the sheet 
you want to move on the list and click the up or 
down arrow buttons. Changes in the sheet order can 
immediately be seen also in the sheet tab row on the  
PromoLog main window.

Deleting
To delete a sheet, select the sheet you want to delete 
and click the red cross button. You will be asked to 
confirm the deletion because this operation cannot 
be undone.

Editing
To edit sheet parameters, click the index finger but-
ton or double-click the sheet’s name on the sheet 
list. To quickly rename the selected sheet, click its 
name on the list. The sheet name can now be edited 
on the list. When ready, press ENTER.
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Parameters

Name
A common parameter for all PromoLog objects. 
Sheet’s name is displayed on the sheet tab in the 
sheet tab row on the PromoLog main window.

Information
Additional sheet information. This information is 
shown on the sheet list.

Lock when Activated
If Yes, the sheet will be locked when the application 
is activated.

Locked
If Yes, the sheet is locked. Module displayed on the 
sheet cannot be moved or resized.

Sheet Background Color
Color setting for the sheet background.

Image
Sheet background bitmap image file.

Autosize
If Yes, the sheet will automatically take the size of 
the background bitmap image.

Width, Height
Width and height of the active sheet area in pixels.

Left, Top
Position memory for the horizontal and vertical 
scrolling bars of the sheet.

Horizontal Grid, Vertical Grid
Horizontal and vertical grid spacing in pixels. This 
grid can be used to align module displays on the 
sheet.

Print Orientation
Paper orientation to use when printing the sheet.
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Alarms

PromoLog shows all active alarms in the Alarm List 
window. You can open the Alarm List window either 
by clicking the  button on the toolbar or by press-
ing F8.

Acknowledge alarm

Edit channel parameters
Edit channel host parameters

Alarm message

Alarm parameters

Alarm parameters can be defined individually for all 
channels.

Advanced parameters are marked with  icon in 
the parameter tree. To enable visibility of these pa-
rameters press down the  button.

Both High and Low Alarms have the same 
parameters.

Enabled
Yes = alarm is enabled
No = alarm is disabled

Limit
When the channel value exceeds the limit value the 
alarm is activated.

Hysteresis
If the limit value is exceeded, the channel reading
must drop below the limit value plus or minus hys-
teresis before the alarm is cleared.

This prevents alarm from cycling on and off when 
the channel reading is close to the limit value.

Delay
Alarms do not appear in the report generated by a 
Surveillance Report module until the delay time has 
expired.

Alarm limit
Hysteresis

Alarm activated Alarm cleared
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Sound alarms

PromoLog can play wav audio files when alarm 
events occur.  To enable sound alarms, select 
Application Setup from the Design menu or press 
F2. Then press down the  button to enable visibil-
ity of the advanced parameters.

Sounds > Alarm Report 
Click the browse button next to the text box and 
browse to the file you wish to play when an alarm is 
reported. Other audio files are linked equally.

Sounds > Alarm Cancel 
This audio file is played when the alarm is cleared.

Sounds > Alarm Pending
This audio file is played repeatedly when one or more 
alarms are pending.

Remote Target
The phone number to which the alarms will be sent. 
If defined, this parameter overrides the General 
Alarm Target parameter of the Surveillance Report 
module.

Report Message
This is the message shown in the Message field of 
the Alarm List window. The message is also added to  
a report generated by a Surveillance Report module 
if the alarm occurs.

Cancel Message
This message is added to  a report generated by 
a Surveillance Report module when the alarm is 
cleared.

Acknowledge Alarms
When the alarm is activated this parameter is set to 
No by PromoLog. When the alarm is acknowledged 
by user this parameter is set to Yes. 

Alarms can be acknowledged by selecting an alarm 
and pressing the  button on the toolbar.  Acknowl-
edged alarm is shown in the Alarm List window as 
long as the channel reading exceeds the limit value 
but it is not counted as an alarming channel.

A message is added to a report generated by a Sur-
veillance Report module when an alarm is acknowl-
edged. 
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Nokeval SCL Connection Wizard

Nokeval SCL Connection Wizard searches for SCL 
devices that are connected to a USB port and auto-
matically creates corresponding modules.

To start the Nokeval SCL Connection Wizard, 
select Design > Wizard > Start Nokeval SCL Con-
nection Wizard.

If you haven’t already added interfaces, SCL Con-
nection Wizard asks if you want to create one now. 
Click Yes to continue. 

Select the interface you want to use. SCLWizard is 
the default, if no interfaces were created before run-
ning the wizard.

Then select the USB device from the drop-down 
menu and select the correct baud rate for the device.

Click Start SCL Device Scan button to start 
searching for devices.  Scan progress is displayed 
in text field next to scan button. Scanning may be 
aborted at any time by pressing the Stop SCL De-
vice Scan button.
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All found SCL devices are added to the list below 
the scan button. To create a corresponding module 
for the device, just drag and drop the module icon 
onto the sheet or press the Create Module on the 
active Sheet button. 

Note that a separate Interface must be created 
for each USB device. 
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Nokeval MTR970/RTR970 Radio Data Receiver

Nokeval Radio Data Receiver module is a module 
for collecting data from Nokeval Radio Data Re-
ceivers.

Adding the module
To add a Nokeval Radio Data Receiver module 
select 2. Inputs from the Design menu.  This opens 
the Input module library window. 

Alternately, you can also use Nokeval SCL 
Wizard to automatically add and configure 
the module. See chapter Nokeval SCL Wiz-
ard on page 29. If you used the wizard tool, 
jump to the paragraph Using the module.

Create a new Nokeval Radio Data Receiver module 
by dragging the Nokeval Radio Data Receiver icon 
onto the active sheet. Alternatively, you can also 
press the blue plus button or double-click the name 
of the module.

Double-click the module to open  parameter editor 
window.
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Before the Nokeval Radio Data Receiver module 
can be used, the interface and SCL address must be 
configured.

When you select the Interface item from the menu 
tree, a list of all interfaces is shown at the right side 
of the window. Select the interface to which your 
device is connected.

See the chapter Creating an Interface if you haven’t 
already created the needed interface.

Select the Address subitem from the menu tree 
and type in the SCL address of the device.

The receiver type updates automatically to 
the menu when the application is running 
and the module receives a response from the 
device.

Click close button to exit parameter editor.

Using the module

Nokeval Radio Data Receiver module doesn’t require 
any configuration besides the serial communication 
settings done while adding the module.

The Nokeval Radio Data Receiver module is divided 
into two parts. The upper part shows status informa-
tion about interface and receiver while the lower part 
shows information about latest received data packets.

PromoLog queries new data packets only 
while the application is running.

The following table explains the columns:
Field Description
Age Time from reception
Device Radio transmitter’s type
ID Radio transmitter’s identification number
Signal Radio transmitter’s signal level in dBm
Battery Radio transmitter’s battery voltage in V

Device type and 
serial number

Name and status of 
the interface

Latest response 
from the device

Device 
status
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Click the Start! button to start the application and 
also click the Module list button to open the Module 
List window. 

When the application is running, Nokeval Ra-
dio Data Receiver module automatically adds all 
detected radio transmitters to the module list. 

Some configuration options are disabled when the 
application is running, therefore when all transmit-
ters are listed, it is recommended to stop the applica-
tion using the Stop! button to continue building your 
application.

You can now view transmitter data by dragging the 
modules from the module list onto the active sheet. 
Alternatively, you can also select the module and 
click the blue plus button.

To configure the transmitter module(s) see the chap-
ter Nokeval Wireless Transmitters on page 34.

Module List button

Start! button
Stop! button
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Nokeval Wireless Transmitters

One Nokeval Wireless Transmitter module repre-
sents one wireless transmitter measuring channel. 
One wireless transmitter can have one or more mea-
suring channels. Compatible wireless transmitters 
and their channel counts are listed on the left.

This chapter explains how to create and configure 
these modules manually. Read the chapter Nokeval 
MTR970/RTR970 Radio Data Receiver to learn 
how to create these modules automatically. 

The wireless transmitters supported by this module 
have different characteristics and they produce 
different types of measurement data. This must be 
noted when configuring the corresponding module.

The graphical display is basically the same for all 
transmitter types. The module can be configured so 
that the transmitter and sensor types are shown on 
the display as in the example.

Main features of the module display are a trend 
graph and a large digital display of the most recent 
measurement value. The display also features mea-
surement unit, alarm limits, received signal level and 
battery level indicators.

Nokeval Wireless Transmitters

MTR260 (1 channel)
MTR262 (1 channel)
MTR264 (4 channels)
MTR265 (1 channel)
MTR165 (1 channel)
RTR860 (2 channels)
FTR860 (2 channels)

Signal and battery 
level indicators

Measurement unit 
and sensor type

Alarm limit 
displays

Module Display

Name of the 
module Active areas of the module are highlighted using

light blue. You can set the display time span, alarms 
levels,  minimum and maximum values of the value 
axis directly by clicking the corresponding active area 
in the module.

When you click an active area of the module, a small
entry window appears, prompting to enter a new
value.

Name of the input 
channel

Value
display

Time axisValue axis Alarm limits

Toggle display size

Sensor type
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Nokeval Wireless Transmitter modules can be used 
with all Nokeval MTR series wireless transmitters. 
One module is needed for each wireless measuring 
channel. These modules are usually created automati-
cally by PromoLog as described in chapter Nokeval 
MTR970/RTR970 Radio Data Receiver on page 31. 

This chapter describes how to manually create and 
configure the necessary modules. The configuration 
includes setting the transmitter ID numbers.

Adding the module
To add a Nokeval Wireless Transmitter module, 
select Module Library from the Design menu.  This 
opens the module library window. 

Create a new Nokeval Wireless Transmitter module 
by dragging the Nokeval Wireless Transmitter icon 
onto the active sheet. Alternatively, you can also press 
the blue plus button or double-click the name of the 
module.

Double-click the module to open parameter editor 
window.
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Before the Nokeval Wireless Transmitter module 
can be used, the transmitter’s ID number and type 
must be set:

Select Transmitter parameter from the left-hand 
pane and enter the ID number printed on the wire-
less transmitter you want to associate with this mod-
ule.  This unique transmitter identification number 
binds the physical transmitter unit to the module 
used in PromoLog to represent it.

The Transmitter > Type parameter is automatically 
updated when data is received from the transmitter.

Select Name parameter from the left-hand pane and 
enter a descriptive name for the measuring point the 
transmitter unit will represent. This name will also be 
displayed on the title bar of the module and in the 
Module List window.

You may also want to make the wireless transmitter 
type and identification number show on the module 
display. To do this, enter the transmitter type and 
ID number in the input channel name field. You can 
format this text as you wish.
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Parameters

Double-click the Nokeval Wireless Transmitter 
module to open module’s parameter editor window.

Name
A common parameter for all PromoLog objects. 
Module’s name is displayed on the top part of the 
module window and in the Module List window.

Transmitter 
Transmitter identification number. This number 
(prefixed with ID) is printed on the label attached to 
the transmitter unit.

Transmitter > Type
The type of the transmitter. This parameter is auto-
matically updated when data is received from the 
transmitter.

Transmitter > Reception Timeout
Maximum allowable time interval between recep-
tions. If there are no receptions from the transmitter 
within this time, a timeout condition is assumed and 
---- is displayed instead of the last reading. 

You can change the name of the input channel by 
typing a new name to the Name text box on the 
right-hand pane.

If you want to save the channel values to disk, check 
the Log to file check box. For more information 
about saving channels to disk see page 120.

 > Display
The display type. Possible types are graph, digital 
display, vertical bar, horizontal bar, vertical indicator 
and horizontal indicator. 

The Display parameter item has the following 
subitems:

Number Format
The number of visible decimal digits.

Unit
The measurement unit that is shown on the 
display, for example, in the sample pictures the 
measurement unit annunciator is °C.
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 > High/Low Alarm
Module’s alarm settings are done in this submenu.

Alarm items have two subitems:

Enabled
Yes = alarm is enabled
No = alarm is disabled

Limit
Limits are highlighted in the display as shown on 
the left-hand column.

 > Input Type
Select the sensor used with the transmitter. The type 
of the sensor is shown in the module’s display. This 
parameter is used to determine fault conditions. 

To edit the limit values of User Defined sensor op-
tion, enable the visibility of advanced parameters by 
pressing down the  button and edit High/Low 
Limit parameters. Fault text is displayed if the chan-
nel reading exceeds these values.

Time Span
Time span of the graph display

Maximum
Upper limit of the graph / bar / indicator display.

Minimum
Lower limit of the graph / bar / indicator display.

 > Report
This parameter controls whether the readings are 
included to a report generated by a Surveillance Re-
port module or not. If a Surveillance Report module 
doesn’t exist this parameter has no effect.

Never the value is never included
Alarms the value is included when an alarm is 

triggered or canceled
Always the value is always included

Time Span
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 > Use
If you are using the transmitter for temperature 
monitoring you can select pre-defined settings for 
the module using the option list on the right-hand 
pane.  MTR260 Transmitter modules display this 
text in the module window instead of the sensor 
type.

 > Linearization
This parameter is only used for transmitters 
with thermocouple sensor. Select the type of 
the thermocouple used from the option list 
on the right-hand pane. 

RTR970PRO radio receiver with logger can 
also be used to calculate the linearization. If 
you have configured the RTR970PRO to 
calculate the linearization for the transmitter 
in question, set this parameter to None.

MTR970 and RTR970 radio data receivers 
cannot be used to calculate linearization.
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TROUBLESHOOTING

Interface failure during startup
Device failure during startup

Nokeval Wireless Transmitter
Licensing
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Interface failure during startup

The most common reason for this error is a wrongly 
configured interface. 

Open the Communication Interface setup window 
from Design > 1. Interface to see the more specific 
error message.

USB error: Device not found when opening device 
with Serial Number...
The Serial Number parameter configured for the 
interface doesn’t match any found device. This may 
happen if you opened a demo application that con-
tained USB interfaces. 

Double-click the module and select the Serial 
Number parameter from the left-hand pane. At the 
right-hand pane is now listed all found USB devices 
that you can use. Select the correct device from the 
list and close the parameter editor window.

USB failure: Device Serial Number not set
The Serial Number parameter configured for the 
interface is blank.

Double-click the module and select the Serial 
Number parameter from the left-hand pane. At the 
right-hand pane is now listed all found USB devices 
that you can use. Select the correct device from the 
list and close the parameter editor window.
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The most common reason for this error is an input 
module that has the interface configured wrongly. 
Click the More details button to see what module 
caused the problem. 
 
Double-click the line describing the problem to 
open the module’s parameter editor.  Open also the 
Communication Interface setup window from De-
sign > 1. Interface.  

The following error messages are possible:
 

Device interface not available
This means that no interface is defined for the 
module or the interface defined no longer exists. 

In the module’s parameter editor window, select the 
Interface parameter from the left-hand pane and 
then select the correct interface from right-hand 
pane. If you haven’t created the interface yet, see the 
chapter Creating an Interface on page.
 
 
 

Device interface closed
The interface that is defined for the input module is 
disabled.  Enable the interface by checking the box 
in front of the module’s name in the Communica-
tion Interface Setup window.

Device failure during startup
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Device is not responding.
PromoLog did not receive any response from the 
device. Check that the module’s Baud Rate pa-
rameter matches the device’s settings. This error also 
occurs if the Interface > SCL > Address parameter 
is incorrect.

If these parameters are correctly set the problem is 
probably in the physical connections. 

Error opening interface
PromoLog was unable to open the interface de-
fined for the input module. This usually means that 
same resources are used by some other interface in 
PromoLog or some other program. 

See the more specific description from Message field 
in the Communication Interface Setup window.

Hardware error: Invalid port number
The COM port defined for the interface does not 
exist. Double-click the interface’s name and select 
the COM Port parameter from the left-hand 
pane. Then use the AutoScan button to search for 
all available ports and type in the correct COM 
port number.

Hardware error: Invalid port already open
The COM port defined for the interface is already 
open. Check that no other interface in PromoLog 
or program is using the same COM port. 



PromoLog User Manual44

Incorrect reading when using thermo-
couple sensor

The value displayed in Wireless Transmitter module 
is close to zero if the transmitter is in room tempera-
ture and the Linearization parameter of the module 
is se to None. 

If the sensor is not attached and the Linearization 
parameter of the module is se to None, the value 
displayed is over 700.

Open the module’s parameter editor window and se-
lect the Linearization parameter from the left-hand 
pane. After that select the linearization matching 
your sensor type from the right-hand pane.

For more detailed instructions how to configure the 
module see the instructions on page 34.

Nokeval Wireless Transmitter module

Fault text

The Fault text is displayed if the channel reading 
exceeds the limits determined by the Input Type pa-
rameter. Fault condition may be caused by a broken 
sensor wire or a loose sensor connection. 

Make sure that the sensor is properly attached and 
the correct Input Type is chosen. 

If the problem still exists, contact the manufacturer 
for service.
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Licensing

Unlicensed operating time expired

Before reading further, make sure that you have 
entered the license key as instructed on page 14.

This solution only applies if you are using Nokeval 
Serial Converter (DCS770, DCS771, DCS772 or 
RCS770) as a license dongle. 

Using Nokeval Serial Converter as a license dongle 
requires that USB is selected as a transport layer for 
the serial interface.

To check this, stop the application and open 
the Communication Interface Setup window by 
selecting Design > 1. Interfaces.

If the transport layer is set to COM, delete the in-
terface using   button. Then press the  button to 
add a new interface.

Name the new interface exactly as the deleted in-
terface. In this way you do not have to change the 
interface in input modules. Select USB as a transport 
layer and press OK button.

Double-click the name of the interface that was just 
created to open the interface’s parameter editor. 

Select Serial Number parameter from the left-hand 
pane and then the correct serial number from the 
right-hand pane. Set also the correct Baud rate for 
the device.

Close the parameter editor window and the Com-
munication Interface Setup window using Close 
buttons. 

Now the interface is recreated using USB as a trans-
port layer and PromoLog is able to authorize the 
license key.

Transport Layer is set to COM


